This chapter provides some general information about managing printing on the Phaser 790, and gives you some hints on using the Command WorkStation windows to monitor and manage print jobs. It suggests ways to guide users so their jobs are more likely to print correctly the first time. The chapter also follows the course of a print job and shows possible ways to expedite jobs and take advantage of the special capabilities provided by the Command WorkStation.

For additional information about utilities and functions that are related to job management at the Command WorkStation, refer to the chapter Introduction to the Command WorkStation.

Communicating with users

The Command WorkStation interface facilitates communication between users and operators. All the same, users who originate print jobs may need to become better informed about the Phaser 790, so they can select the appropriate options for their jobs.

What the user needs to know

Users require the following information:

- The name of the printer on the network and the names of servers sharing the printer
- Access status
- Connections that do not require operator intervention—Direct connection and/or Print queue (for jobs that do not go to the Hold queue)
- How long jobs will be held before they are deleted
• List of printer settings (from the Configuration page)
• List of installed fonts
  If user applications do not download fonts automatically, indicate if users can download fonts to the printer, embed them in documents, or supply them to the system administrator for downloading.
• Requirements for Notes fields (information which appears in the Job Log), such as department name, account code, phone number or extension
• Resident calibration target and date of current measurements
• Custom simulations
  Include types of targets represented by any custom simulations. Although users see these print options (CMYK Simulation), they should not select them if there are no custom targets on the server.
• IP address or DNS name of the printer so users can access Fiery WebTools to see if their jobs have printed
• Installed options
• Available media, alternative choices, standard tray/media configurations
• Suggestions for the Instructions field
• Information users might find in the WebLink web site
• Instructions for setting up the printer on client workstations
• Sources of PostScript printer drivers, PPDs, color reference files, and additional information
• Recommended PPD settings
• Conflicting settings and common PostScript errors
How users communicate print requirements

Explain to remote users the information the administrator or operator must know in order to print the jobs they send. The Instructions field is suited for communication about the job requirements. Notes fields appear in the Job Log, so they are more suited for accounting, billing, and job cost information.

Users can provide information with the print job, including:

- Information entered in the Instructions field or the Notes fields, including any special requirements for your site
- Job ticket information provided by PPD option settings (job properties)

Instructions and Notes fields include the following:

- User name and phone number
- Priority, due date, request for notification
- Number of copies needed
- Request that operator do color check
- Hold job for future printing or future reprinting
- Merge with another job, and merging instructions
- Quantity of paper required
- Future requirements for the job
Customizing the Command WorkStation window

Customize the display of job ticket information in the Queues window by rearranging the column headings. You can tighten the columns, add new column headings, move columns, and delete column headings.

*The Job Title and User columns are always at the left and cannot be moved or deleted. You can only add column headings to the right of the User column.*

To customize the Queues window display:

1. Right-click the **column heading**.
   
   A menu is displayed. The Add submenu lists the headings that are not already displayed.

2. Select the **options** you want to display, and the **sequence** in which you prefer to view them.
   
   Add, delete, or move a column by holding down the right mouse button on the name of the appropriate column heading; release the button after choosing one of the menu options:
   
   - **Add** one of the listed columns to the display at your mouse position.
   - **Move Left, Move Right**—move the selected column left or right.
   - **Delete** the selected column.

   The Job Title and User columns are required—all others are optional.

3. Adjust the column widths.
   
   Select the column border in the heading and drag to the left or right. You can change the column widths at any time.

   If you display the Instructions or Notes column, which shows information typed into the Instructions field by the user, you can reduce the width of the column so you can just see whether or not there are instructions in it. With a narrow Instructions column, if you want to read detailed instructions, double-click the job and select **Notes** from the Job Properties window.

   The operator can edit or annotate the information in the Instructions field. It remains with the job as long as the job is on the server. The operator cannot edit the Notes fields.
17. Managing print jobs at the Command WorkStation

**Setting Command WorkStation Preferences**

Select **File** and **Preferences** to access the Preferences dialog box.

![Preferences dialog box]

<table>
<thead>
<tr>
<th>Menu</th>
<th>Select</th>
<th>To do:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences\General</td>
<td>Enable Animation</td>
<td>Turn on or off animation of the status bars.</td>
</tr>
<tr>
<td></td>
<td>Enable Popup Help</td>
<td>Turn on or off short captions that appear when you pause the mouse over window elements; the captions identify the main parts of the Command WorkStation window.</td>
</tr>
<tr>
<td></td>
<td>Units</td>
<td>Specify the type of unit (Points, Inches, or Millimeters) to use in the display for custom page sizes.</td>
</tr>
<tr>
<td></td>
<td>Temporary path</td>
<td>Specify a location for temporary files created by the Command WorkStation application.</td>
</tr>
<tr>
<td>Preferences\Filter</td>
<td>Helper Application</td>
<td>Specify the path to a helper application from which to view data in the active window; this application opens automatically when you select <strong>View in Helper App</strong> from the Window menu.</td>
</tr>
<tr>
<td></td>
<td>Template path</td>
<td>Specify the path to where Filter template files are saved.</td>
</tr>
</tbody>
</table>
Printing server information pages

Using the Print Pages command, you can print various special pages of information stored on the printer.

1. Select Print Pages from the File menu.
2. In the Select Printer area, specify where you want to print the pages:
   - **Server**—The pages you specify are sent to the printer.
   - **Local Printer**—Enables you to print the Configuration page, Archive Log, and Queues to any printer installed on your Windows workstation.
3. In the Select Pages area, specify the pages you want to print:
   - **Configuration**—Prints the Configuration page, which gives the current server and device configuration. This page lists general information about the hardware and software configuration of the printer, the current settings for all Setup options, information about the current calibration, and the Ethernet and Token Ring addresses of the printer.
   - **PS Test Page/PCL Test Page**—A Test Page enables you to confirm that the printer is properly connected and provides color and grayscale samples for problem solving. The following settings are among those listed on the Test Page: Printer Name, Printer Model, color settings, calibration information, date and time the Test Page was printed.
   - **Control Panel Map**—Prints the Control Panel Map, which is an overview of the screens you can access from the Control Panel. For information about using these screens to set up the printer, refer to the chapter Performing setup from the Printer Control Panel.
   - **PS Font List/PCL Font List**—Prints a list of all fonts currently resident on the printer.
   - **Color Charts**—Prints samples of the RGB, CMY, and PANTONE colors available from the printer.
   - **Job Log**—Prints a log of the last 55 jobs processed or printed. For information about the fields in the Job Log and about printing it in other forms, refer to the section Using the Job Log.
4. Select **Print**.

5. Perform one of the following:
   - If you selected **Server** in step 2, specify the number of copies to print and select **OK**.
     The page(s) are printed to the Phaser 790.
   - If you selected **Local Printer** in step 2, select the desired **printer** in the Print dialog box, specify the **number of copies** to print, and select **OK**.
     The **Configuration** page is printed to the printer you specified.

Server information pages printed with the Print Pages command appear in the Job Log with a User Name of Operator even if you logged in as Administrator.
Workflow scenarios

The workflow at your site will depend on the number and complexity of jobs and the amount of responsibility given to the operator. This section suggests some ways you might interact with a job.

Scenario 1

At this site, the Print queue is enabled, and anyone at the Command WorkStation can view the progress of jobs. A small job is sent to a server and copier that are not busy. The job progress can be watched from the top to the bottom of the Queues window.

The green light on the Phaser 790 flashes, the network icon blinks; on the Command WorkStation, the Spool status bar is animated and the job title appears. As soon as spooling has finished, the Spool status bar is cleared and the RIP status bar animates. Almost immediately thereafter, the RIP status bar is cleared and the Print status bar animates. The printed job is listed below the Print status bar and the job pages emerge from the Phaser 790. You move it to the mailbox of the person who sent the job.

Scenario 2

At this site, all jobs come to the Hold queue and therefore require operator intervention to proceed.

Again, the network icon blinks, the Spool status bar is animated, and now in the Spool area (below the status bar) the job title comes into view. In a few moments the job is on the list, and the operator has time to scan the headings for the job ticket information—media type, special instructions, copies, and pages.

The operator must check printer readiness, job priority, and purpose (final output or a test print). The operator decides whether to put the job in the print queue or hold it before processing it further. If the operator does nothing, the job remains in the Spool area, and the file remains on the printer disk.
Two examples follow.

- If this is a routine job that does not call for special handling, the operator can right-click the job and select **Print**. The RIP status bar and the Print status bar animate. The printed job is listed below the Print status bar and the job pages emerge from the Phaser 790.

- Another job may be a large job that the operator has not seen before. The Instructions field indicates that the originator of the job wants to check one printout of the job before printing another 50 copies. The operator ensures the Copies field is set to 1, right-clicks the job, and selects **Print and Hold**. The RIP status bar and Print status bar animate, then copy 1 of the job emerges from the Phaser 790. The operator calls the sender of the job for approval. When the job is approved, the operator sets the number of copies to **50**, right-clicks the job now being held in the RIP area, and selects **Print**.

### Scenario 3

Everyone has discovered the Phaser 790 on the network and jobs are coming in rapidly. The operator right-clicks several routine jobs in the Spool area and selects Print to let the server print them one after the other. The operator selects Print and Hold for jobs that require reprinting soon. The operator removes printed jobs from the output trays and replenish media.

While some jobs are flowing through the queues and printing, the operator prepares for jobs that have special requirements, such as special paper or notifying the originator of a job that a PostScript error occurred.

Before the operator loads special paper, he or she must ensure all pending jobs are in holding areas. When an especially important job is spooled for RIPping, the operator can right-click **Process Next**.
Canceling jobs

You may need to cancel a job after it has been routed for processing or printing. You can cancel a job only while it is being RIPped or while it is being printed. You cannot cancel a waiting job (white job row) that is routed for RIPping or printing.

Canceled jobs may be partially printed, and may include pages with one or more missing color planes, or pages that are completely blank.

- **Canceling jobs during processing**—While a job is being RIPped, and its name appears in the RIP status bar, perform one of the following:
  - Select the **Cancel RIPping** command from the Server menu and press the F7 key.
  - Right-click the **RIP status bar** and select **Cancel RIPping**.

  When the RIP job is canceled, the Canceling message is displayed on the Printer Control Panel. The name of the canceled job appears in the Job Log.

- **Canceling jobs during printing**—While a job is printing, and its name appears in the Print status bar, perform one of the following:
  - Select the **Cancel Printing** command from the Server menu and press the F8 key.
  - Right-click the **Print status bar** and select **Cancel Printing**.

  When the print job is canceled, the Canceling message is displayed on the Printer Control Panel. The name of the canceled job appears in the Job Log.

- **Canceling at the Control Panel**—If you are at the printer, press the top button on the server Control Panel while you can read the name of the job that is processing or printing.
17. Managing print jobs at the Command WorkStation

Viewing and overriding print settings

When logged in as Operator or Administrator at the Command WorkStation, you can view, override user job settings of, and print any job in the Queues window and view job settings for jobs in the Archive window. Using the Properties dialog box, you can view and override job settings for a single job or for multiple jobs at once. When viewing multiple jobs, you can override settings for each job independently or override a setting for all the jobs at once.

*You cannot override the print option settings for PCL jobs.*

- To view the properties for a single job, perform one of the following:
  - Double-click the job line.
  - Select the job and **Properties** from the Job menu or right mouse menu.

- To view the properties for multiple jobs at once, **Shift-click** to select contiguous jobs, or **Ctrl-click** to select non-contiguous jobs. Select **Properties** from the Job menu or right mouse menu.

*To retain a copy of the job with its original settings, duplicate the job and rename the duplicate before you change any settings.*

To override a setting for a single job, right click the current setting and select the override setting from the drop-down box.

*For some options, changing the setting requires that the job be reRIPped; these options show an icon to the left of the option name.*
To override settings for all jobs listed in the Properties dialog box, right-click the name of the print option (the row header) at the left of the dialog box and select the override setting from the drop-down box.

The Properties dialog box displays all the job settings encoded by the PostScript or PCL printer driver that can be decoded by the printer. If the operator has not changed anything, these are the settings a user entered before sending the job. There are two exceptions to this: Page Range and Scale.

Some print options that are available in the printer driver are not displayed in the Properties dialog box. For information on specific print options and settings, and where they can be set, refer to the chapter, Print options.

When the Properties dialog box opens, the page range is always shown as All pages and the scale is always shown as 100%. All pages denotes that all the pages specified by the user in printing the job; it may not include all the pages in the original document on the user disk. Similarly, 100% scale indicates 100% of the magnification specified by the user.

The Properties dialog box does display all the remaining user settings, including user Instructions and Notes fields.

- Instructions fields are intended to be viewed and annotated by the operator, but their contents are associated with the job and are deleted when the job is deleted after printing.
- Notes fields can be viewed but cannot be changed by the operator; their contents are transcribed to the Job Log just as the user sent them.
Managing jobs with multiple printers

You can connect to up to five printers simultaneously from the Command WorkStation. This allows you to view and manage jobs being processed by multiple printers from a single location, and also to balance the job load between printers of similar capabilities.

- If you connect to multiple printers from the Command WorkStation, you can easily switch between them by selecting the printer selection tabs.
- You can use the Send to <Server> command to transfer jobs between color servers.

For more information, refer to the chapter *Introduction to the Command WorkStation*.

To view and manage jobs on multiple color servers:

1. Configure the connection to the first server and log in.
   For information on configuring the connection to the server, refer to the chapter *Connecting to the network*.
2. Select a blank server selection tab.
3. Configure the connection to the next server and log in.
   The Command WorkStation windows show the job lists for the additional server. You can route and manage the jobs processed by this server as long as you are logged in.
4. To switch servers, simply select the other server selection tab.
   Once you have logged in, you do not need to log in again unless you have logged out.
   If the servers are extremely busy with continuous jobs, you may see some delay in updating the Command WorkStation window when you switch between servers. Job lists may be blank for some seconds until updating is complete.
To transfer jobs between color servers:

1. Log in to more than one color server, as described above.
   
   To transfer jobs between color servers, both color servers must support the Send to <Server> command.

2. In the Queues window of the source color server, select the job(s) you want to transfer.
   
   You can select any held jobs in the Spool or RIP areas.

3. Select the Send to <Server> command from the Job menu.

   The actual command contains the name of the other color server currently connected to the Command WorkStation; for example, Send to Aero_DC2006. If two or more additional color servers (in addition to the originating server) are connected to the Command WorkStation, multiple Send to <Server> commands display in the Job menu.

   Jobs are transferred from the source server to the same area on the target server (from Spool to Spool, from RIP to RIP).

   You cannot perform any other Command WorkStation functions while files are being transferred between servers.

4. After verifying that the jobs were successfully transferred, you can delete them from the originating server, if you wish.
Archiving jobs

PostScript and raster data jobs can be archived internally to the Phaser 790 or the ZIP drive, or externally to the Command WorkStation hard disk or network drives.

1. In the Queues window, select any held job in the Spool or RIP areas.
2. Select Archive from the Job menu.
3. To archive the job(s) internally to the Phaser 790 or to the ZIP drive, select OK.
   The job(s) are archived internally.
4. To archive the job(s) externally to the Command WorkStation hard disk or to a device on the network, select Add.
5. Browse to the device and folder to which you want to archive the job(s) and select **OK**.
   The Archive Options dialog box shows external devices as available archive volumes.

6. If applicable, select **Archive rasters**.
   The Archive rasters option is dimmed for PostScript data jobs and for jobs being archived to Server Internal.

   ![Archive Options dialog box]

   Raster data files may be large and therefore may take considerable time to archive.

7. Select an archive volume and select **OK**.
   To retrieve jobs archived to external devices, use the **Import** command.

   Copy or move the archived job to a new destination by right-clicking the desired **job** and selecting **Move To** or **Copy To**. You cannot select the printer as the archive destination. Additionally, if you archived the job by selecting Server Internal, you cannot copy or move the archived job.
**Importing archived jobs from external media**

You can use the Import command to find and retrieve jobs previously archived to external devices. This command can be used to retrieve files archived from the current printer or from another printer that supports external archiving.

To import an archived job from an external device:

1. Perform one of the following:
   - Select **Import** from the Job menu in the Queues window.
   - Right-click the **Spool status bar** and select **Import**.

2. Select the device containing the job(s) you want to import.

3. Select **Add** to import files from other archived volumes.

4. Select **OK**.

The job is imported to the same area in the Queues window (Spool or RIP) from which it was archived.
Using the Job Log

The Job Log is the list of all processed and printed jobs, including the date and time printed, and all the characteristics of the job. The Administrator can set Job Log preferences for clearing and printing the Job Log automatically, and for Job Log page size. For more information, refer to the chapter *Introduction to the Command WorkStation*.

1. To view the Job Log in a specific application, specify the log in the Preferences dialog box and select **View** in the Helper Applications from the Window menu.

2. To print the Job Log, perform one of the following:
   - Use the **Print Pages** dialog box
   - Select **Print** from the Window menu
   - Export the job log to a tab-delimited text file (select Export from the Window menu). The exported Job Log file can be imported into a spreadsheet, database, or word processing application for job accounting purposes.

If the Filter command is used to display only a portion of the Job Log (such as jobs for the current day), only that portion of the Job Log is printed or exported.
3. To update the Job Log, select **Refresh** from the Window menu.

4. To clear the entire Job Log, select **Clear Job Log** from the Server menu.

The Job Log window displays a list of all the jobs and the following information: status, document name, user, date, start time, end time, process time, page description language, size, device, page size, media, number of originals, number of color pages, number of black-and-white pages, and total number of pages. Information in the Notes 1 and Notes 2 fields is displayed if users entered this information when they printed.

The text in the Status column provides information about the job:

- **OK** The job was printed normally.
- **Cancel** The job was canceled before printing was completed.
- **Error** An error occurred during processing or printing.

Use the scroll bar at the bottom of the window to view all the fields in the Job Log window.
Other server management commands

These additional Server menu commands are used to manage server performance, configuration, and status. Some of these commands are available only through the Administrator log-in:

- **Manage Color**—Opens ColorWise Pro Tools
- **Manage Fonts**—Allows you to delete fonts from, as well as add fonts to, the printer
- **Clear Job Log**—Clears the Job Log only
- **Reboot**—Causes the printer to be rebooted, just as if you had selected Restart Server from the Shut Down menu on the Control Panel
- **Clear**—Clears all jobs in all server queues, as well as all jobs archived on the printer, the index of archived jobs (in the Archive window), and the Job Log
- **Setup**—Invokes Printer Setup (see the Configuration Guide)
- **Log out**—Closes the connection to the printer

For more information, refer to the relevant sections within this chapter *Using ColorWise Pro Tools* and *Introduction to the Command WorkStation*. 